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Introduction 

The Accelerated Learning Program (ALP) is designed to improve the percentage of ENGL 052 

students who pass ENGL 052 and ENGL 101. Under ALP, students whose placement is ENGL 

052 enroll in designated sections of ENGL 101. These sections are composed of 8 ALP students 

and 12 students whose placement is ENGL 101. In addition, the same 8 ALP students are 

enrolled in a designated section of ENGL 052 taught by the same instructor, a companion course 

which should immediately follow the ENGL 101.  

This handbook describes some of the various approaches instructors who have participated in the 

program so far have found effective.  In this handbook, we have compiled a few principles that 

we hope will help make your ALP experience more enjoyable, rewarding, and effective. It is 

filled with lessons, links to wonderful PowerPoints, and other information. While it is aimed at 

The Community College of Baltimore County ALP instructors, any school‘s faculty is invited to 

use any of the information below. 

This is intended to be a living document. So please feel free to send links, lessons, or anything 

you think will be helpful to other instructors to rmiller2@ccbcmd.edu, and they will be included 

in the next update. 

Set-up  

First and most important is to make sure your ENGL 101 ALP section and your ALP 052 class 

lists align. At CCBC, you should have no more than 10 students in your ALP class and a total of 

20 students in ENGL 101. If you have a problem, immediately contact Peter Adams or 

Jamey Gallagher. 

Your ENGL 101 will be assigned one CRN number and section number. Your ALP 101 section 

will be assigned another CRN and section number. Finally, your ALP 052 class will be given a 

third. Because of this, initially, you will have 3 Blackboard shells set up for your classes: one for 

the ENGL 101 and one for the ALP section of 101, and 1 for the ENGL 052. To make your life 

much easier, we strongly suggest merging the 2 ENGL 101 sections (the twelve ENGL 101 

students and the ten ALP 101 students) into one. This can easily be done be done by sending a 

request to merge sections, which can be found within the forms section of SharePoint and then 

looking for the form under informational technology. 

One of the early decisions you will have to make is whether to inform your ENGL 101 class that 

this is an ALP section. Some of us do it the first day, others the first week, still others during the 

second week, and finally there are those who never mention it to the class. If you do not mention  

mailto:rmiller2@ccbcmd.edu
mailto:padams2@ccbcmd.edu
mailto::jgallagher@ccbcmd.edu
https://ccbcsharepoint.ccbcmd.edu/admin/its/instruct/odl/bb9/_layouts/FormServer.aspx?XsnLocation=https://ccbcsharepoint/admin/its/instruct/odl/bb9/BlackBoard%20Merge%20Requests/Forms/template.xsn&SaveLocation=https%3A%2F%2Fccbcsharepoint%2Fadmin%2Fits%2Fi
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it, you will find that the ALP students usually ―out‖ themselves. There is no hard and fast rule for 

this. Do what feels comfortable and right. 

Some faculty members like to show a PowerPoint in the first two weeks demonstrating the 

effectiveness of ALP. It helps when students understand the opportunity for success they have 

been given. Others like to provide a handout with their syllabus explaining ALP. Feel free to 

modify either of these to fit your needs, and if you can think of improvements, don‘t be shy of 

sending them in! 

One excellent way to start off a semester is a video that Peter Adams has produced, ―Why 

Writing Matters‖. It not only deals with school but also the importance of writing in the rest of 

our students‘ lives.  

Grading 

Remember that you will still have to grade the 2 ENGL 101 sections separately when you turn in 

any mid-term grades (for students who are failing) and final grades on Simon. You cannot 

merge the ENGL 101 and the ALP 101 in Simon. The ALP 052 course remains separate 

within Blackboard and Simon (on-line information for grading). 

Students who pass both courses (ENGL 052 and ENGL 101) are then eligible to take 

ENGL 102 in the following semester. ENGL 052 is a pass or fail course where students 

earn either S (satisfactory performance) or U (unsatisfactory). ENGL 101 is a graded 

course. While D is passing, students must earn a C or better to be eligible to register for ENGL 

102. 

 Students who pass both ENGL 052 and ENGL 101 will be given an S for 052 and a letter 

grade (A, B, or C) for 101 and will be eligible to enroll in ENGL 102.  

 Students who pass ENGL 052, but fail ENGL 101 will receive an S for ENG 052 but will 

be required to retake ENGL 101.  

 Students who fail both courses will receive a U for ENGL 052 and an F for ENGL 101, 

and will be required to register, retake, and pass 052 before they can register for ENGL 

101 again. They are allowed to reregister for an ALP class again. 

 Although it is unlikely to happen, a student who fails 052 but passes 101 will get a U in 

052 and the letter grade he or she earns in 101. If the student's grade in 101 is C or 

higher, he or she is eligible for 102. 

 

http://facultypedagogygroup.wikispaces.com/file/view/PowerPoint+on+ALP+for+students.ppt
http://faculty.ccbcmd.edu/~padams/ALP/Site%20Folder/Fall%202010/faculty/handbook/syllabi/Scott%20052.htm
http://www.screencast.com/t/hcwIYVVh
http://www.screencast.com/t/hcwIYVVh
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It is very important to remember to teach AND grade the entire ENGL 101 class as you 

would any ENGL 101 class. Otherwise you are doing a disservice to your ENGL 101 students 

and your ALP students. The ALP students must do the same work and achieve the same 

results as the rest of the class. Sometimes, because we may get to know the ALP students, you 

may be tempted to give them more of a break; however, this is not doing them a favor as they 

will have to be able to succeed in ENGL 102 and other courses that require writing. And as you 

will read later, ALP students have been successful in ENGL 102. 

1. The requirements for the course and the method by which you will determine the 

student's grade must be specified in your syllabus as stated in CCBC‘s syllabus policy. 

There is flexibility in how to grade in the ALP section. Below are several methods that 

teachers have found effective. 

 One way to determine grades in the ALP 052 section is to develop a point system. Each 

exercise and writing assignment is worth a certain number of points. Points can be 

deducted for absences, number of late arrivals, and missing or late assignments. To pass, 

students must accumulate a specified number of points. This is probably most similar to 

what you have been doing. 

 Because it is difficult to know at the beginning of the semester exactly how many 

exercises and writing assignments will be required, you may want to specify that each is 

worth a certain number of points and that students must accumulate at least 70% of the 

total available to pass the course.  

 A completely different approach to assigning grades in the ALP 052 section is to base 

that grade on the writing the students do in the 101 section. You would look at the 

student's writing in 101 and determine whether the student achieved a C or higher in 101. 

If he or she has not, you would look again at that same writing and determine whether it 

meets the minimum requirements for passing 052. If it does, the student gets an S; if not, 

the student gets a U. 

Pedagogy 

ALP does not have a required, uniform pedagogy. Those who teach ALP 

represent a wide range of teaching styles and philosophies. And yet ALP 

works. According to a study done by the Community College Research 

Center, ALP nearly doubles success rates for its students. A more recent 

study by the CCRC confirms those results! And that success follows ALP students in following 

semesters. If we don't insist on a uniform approach to teaching writing, then what is it about ALP 

that makes it so successful? We are working hard to answer that question. We conduct student 

surveys at the beginning and the end of each  

http://www.ccbcmd.edu/catalog11/senatepolicies/Updated_Syllabus_Policy.html
http://ccrc.tc.columbia.edu/Publication.asp?UID=811
http://ccrc.tc.columbia.edu/Publication.asp?UID=811
http://ccrc.tc.columbia.edu/Publication.asp?UID=1151
http://ccrc.tc.columbia.edu/Publication.asp?UID=1151
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semester, studying data from Banner, conducting occasional focus groups, and scoring essays by 

ALP and 101-level students. We hope all this research into the program will allow us to say 

definitively what it is that makes ALP work; it may also help us revise the program for even 

greater success.  

In the meantime, however, we have some tentative ideas about why ALP is so successful. These 

are the hypotheses we are investigating in our research: 

1. Being told they can take credit-level English increases student confidence.  

2. Being allowed into credit-level English reduces negative attitude caused by the fact that 

they receive no credit for developmental courses. 

3. Being allowed to take college-level ENGL 101 encourages students to feel that they are 

really in college and not in some "pre-college holding pattern" until they get their skills 

up. This effect combined with the fact that the eight ALP students and the same instructor 

take two classes together improves the students' attachment to the college. Taking ENGL 

101 in a class with students who are strong writers provides ALP students with role 

models who are strong writers.  

4. Taking two courses with the same eight students and the same instructor increases bonds 

among the students and between students and instructor. The class size of just eight in the 

ALP 052 course increases this effect.  

- The small class size and the fact that the entire goal of the ALP 052 class is to 

provide the support to help them pass ENGL 101 encourages students to see their 

ALP instructor as a coach rather than a judge.  

5. ALP provides students with increased individual attention primarily because of the small 

class size.  

6. Because of the six contact hours per week and the small class size in the ALP 052, ALP 

improves instruction in grammar, punctuation, and usage.  

7. The small class size, the influence of peers, and the supportive relationship of the 

instructor mean that ALP decreases student behaviors that impede success.  

8. The active interest of the ALP instructor, the availability of outside consultants, and the 

support of other students with whom they have formed friendships reduces the 

interference of non-academic problems with student performance.  

9. Taking the ALP course generates student interest in grammar.  

10. Students perceive what they‘re learning as more useful because they apply it immediately 

in the ENG 101 section instead of being told it will be useful ―next semester‖. 

We recognize that there are a number of effective ways to approach the complex task of helping 

writers with some difficulties grow into successful college-level writers. We celebrate our 

diversity of teaching styles. We also recognize and want you to anticipate that whatever your 

style, you will be changed by the experience of teaching in ALP. All of us have come to 

recognize that the experience of teaching these small groups of students who desperately want to  
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learn to be effective writers has changed us in ways we didn't anticipate. When we teach ALP, 

we are different teachers from what we are when we teach traditional ENGL 052 . . . and so far, 

we have found those differences to be satisfying, even exhilarating. We hope your experience is 

just as positive as ours have been.  And there will be ample opportunity for you to express your 

ideas about what works and what does not. 

 

Syllabus 

As required in every course at CCBC, you must provide your students in both classes with a 

syllabus that follows the CCBC Syllabus Policy. This policy specifies the minimum information 

that must be included in your syllabus. Also, there are a number of syllabi for you to use as 

samples at the end of this section. It is much easier to use one syllabus for ENGL 101; just put 

both CRN numbers and section numbers on the top of the syllabus. 

Most certainly, it is very likely your ALP 052 syllabus will need to be changed to suit the needs 

of your students. We recommend that you explain this to them rather than attempt to lay out a 

day-by-day schedule of assignments or class topics. Some of us lay out a ―general‖ day by day 

syllabus for the first month and then provide another one after. Still, others do lay out a day to 

day calendar and then revise the calendar frequently. Again, there is a lot of room for 

individuality in ALP. One of the most important aspects of the ALP 052 is starting off the 

semester pointing out that you will be open to modifying your plans for a particular day if 

students have questions about material or assignments from the 101 class. In fact, almost every 

ALP teacher starts off each ALP 052 class with, “Are there any questions from 101?” We 

then, if necessary, let that discussion lead the day and adjust our syllabi accordingly. Of course, it 

is necessary to provide your normal detailed 101 syllabus. 

Some ALP instructors have used the 101 syllabus as the outline of what they will do in ALP 052, 

and so, instead of handing out a separate syllabus of 052, they hand out a shorter document, more 

of a supplement to the 101 syllabus, explaining procedures and policies in ALP. You still, 

though, must provide a minimum of what the CCBC Syllabus Policy requires. 

In addition to the information required by the CCBC Syllabus Policy, ALP instructors should 

include the following topics in their syllabi:  

 Plagiarism  

 

http://www.ccbcmd.edu/catalog11/senatepolicies/Updated_Syllabus_Policy.html
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 Cell phones and text messaging  

 Expectations for meeting deadlines for papers and other assignments 

 Attendance and lateness 

 A calendar of scheduled grammar topics 

 A calendar of scheduled writing topics 

 Grading Policy 

Much more detailed information can be found in the CCBC Code of Conduct, which students 

can find in their ―MyCCBC‖ (under my classes my syllabi policy). 

One important thing to remember is that students don‘t memorize or understand the syllabus as 

well as you. It has been said that our syllabi can be as complex for our students to understand as 

credit card change notices are for faculty. Don‘t expect students to be as familiar with or 

understand the syllabus as you might expect. Here is a short exercise that you can adapt if you 

want to see how well your students understand your syllabus 

Below are some tried and true syllabi that we highly recommend you look at when putting your 

syllabus together. 

 

Sample Syllabi 
 

 

Peter Adams      Susan Gabriel 
Side by Side - 101/ALP Course    Side by Side - 101/ALP Course 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

file:///C:/Documents%20and%20Settings/RMiller2/My%20Documents/ALP/Code%20of%20Conduct.pdf
https://myccbc.ccbcmd.edu/_layouts/login3.aspx?ReturnUrl=%2f_layouts%2fAuthenticate.aspx%3fSource%3d%252f&Source=%2f
http://faculty.ccbcmd.edu/~padams/00%20spring%202011/101/Ex1%20Syllabus.html
http://alp-deved.org/wp-content/uploads/2012/12/Side-by-Side-Syllabus-Adams.pdf
http://alp-deved.org/wp-content/uploads/2012/12/Side-by-Side-Syllabi-Susans.pdf
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Writing 

Students in ALP 052 should do a lot of writing. Much of it will be designed to help them 

succeed in 101. Some will involve additional practice in planning, drafting, and revising the 

essay assignments for ENG 101. Examples of other types of writing that should be included in 

ALP are listed below. Sample assignments can be found in Appendix A. 

The teaching of revision is one constant that ALP classes share. In the ALP 052 class, we devote 

considerable time to discussions of how to revise specific students‘ papers that they are writing 

for 101 as well as how to revise the short writings they do in the 052 section. This PowerPoint on 

the revision process has led to wonderful discussions in many ALP classes. While aimed at 

teachers, a number of students have said that it has changed their outlook on writing. 

One of the strengths of ALP is that students have commented on how helpful it is to have a place 

where they can talk about their writing in an environment that is not stressful or judgmental. We 

recommend that ALP instructors strive to create such an environment.  ALP students report that 

they benefit greatly from classroom discussion of drafts of their papers. This seems to be 

particularly true when a relaxed, non-threatening atmosphere can be established. Because of this, 

it is always important to ask a student‘s permission before using his or her paper to display to the 

class. 

In addition to writing connected directly to the papers assigned in ENG 101, students could be 

asked to do some of the following types of writing:  

 paraphrasing and summarizing readings 

 incorporation of quotations from sources  

 citation exercises 

 responses to readings, of both peer and published work  

 journaling  

 freewriting  

 assignments designed to encourage understanding of organization  

 assignments designed to encourage understanding of development  

 assignments designed to encourage understanding of revision 

 writing and revising introductions/theses/other particular parts of an essay. 

 extra essays 

A useful site to help with paraphrasing and summarizing:  

http://owl.english.purdue.edu/owl/resource/619/01/ 

 

http://www.screencast.com/t/OWQ0MGNlMDQ
http://owl.english.purdue.edu/owl/resource/619/01/
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Generally, you need to decide what kind of assignments will best help them in doing well in 

ENGL 101. A number of sample assignments can be found in Appendix A. 

 

 

One of the most difficult topics to deal with in ENGL 101 and ALP 052 is citation. Most of us 

are already familiar with the Purdue OWL, and many of your students will already be familiar 

with citation machine which actually helps create the Works Cited for students. 

 

Major Topics 

Most of the major topics you discuss in your ALP section will parallel what you are teaching in 

ENGL 101. You may find it helpful or necessary to revisit some of the topics more often in the 

ALP section or spend different amounts of time on each of them. Most of these are spelled out in 

the CCBC ENGL 101 Common Course Outline (CCO). 

 Writing as process: inventing, planning, drafting, revising, editing, and proofreading; 

 Audience; 

 Paragraph development - students will learn to develop paragraphs through examples, 

descriptive details, and explanations; 

 Sentence variety;  

 Essay structure; 

 Thesis and unity;  

 Essay development and organization - students will learn and practice ways to generate 

and develop writing ideas. Techniques such as freewriting, listing, clustering, mapping, 

and outlining should be discussed;  

 Revision - Students should be encouraged to see the writing process as one of rewriting 

and revision. This includes more than just editing for surface level errors. Revision means 

re-seeing and rethinking ideas, thesis statements, topic sentences, and paragraphs for 

clarity and effectiveness. If instructors require revisions and make their comments on 

student writing in the form of suggestions for revision, this will assist students in this 

goal; 

 Plagiarism. Students will learn effective methods of summarizing and paraphrasing 

resources to avoid plagiarism. Review in-text citations according to the MLA format;  

 Grammar, punctuation, and usage. You will probably spend much more time on grammar 

in your ALP section than in your ENGL 101 section. ALP students have reported back 

that they have felt as if they became the grammar resource in the ENGL 102 sections;  

It is important, early in the semester, to look at the student writing you are getting to 

determine the errors that occur most frequently in the writing of the eight students in your  

http://owl.english.purdue.edu/owl/
http://citationmachine.net/
http://ccbcmd.edu/media/cco/engl/engl101.pdf


ALP Handbook 11 

 

 

 

section. Based on this assessment, you should make a plan for how and when you will 

address each of them. 

You may want to spread these topics out over the course of the semester and revisit them 

based on your initial and continuing assessment of major errors and their frequency.  

   

Grammar, Punctuation, and Expression 

Perhaps in no area is there as much flexibility and disagreement as there is 

with grammar. However, to pass the course, students must demonstrate some 

competence in the following areas. Unfortunately, it is not so easy to define 

competence. Do you measure it in a test? We suggest that it is the ability to 

find and minimize errors in their own writing. 

Grammar 

o subject-verb agreement  

o verb tense and form  

o pronoun reference and agreement  

o capitalization 

Punctuation  

o avoiding or correcting fragments  

o avoiding or correcting comma splices and run-ons  

o punctuation with independent clauses  

o commas with introductory elements  

o apostrophes 

Expression:  

o avoiding errors with the confusing words on the ENG 052 list 

o avoiding wordiness, redundancy, and repetition  

o avoiding awkwardness  

o avoiding errors with faulty parallelism  

o avoiding errors with point of view shift  

o avoiding vagueness  

o avoiding errors with jargon  
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o avoiding errors with inappropriate, colloquial, and internet/text messaging 

language  

o using a variety of sentence structures  

o effective use of passive voice  

o Students should be able to demonstrate their editing skills in their own writing. 

Some instructors believe that instruction in grammar, punctuation, and expression generally 

works best when carefully structured and, therefore, should not be taught primarily in mini-

lessons squeezed in when time permits. Others like to have a number of mini-lessons ready to 

supplement their more structured lessons enabled them to use a more cyclic approach. 

Usually students improve their skills with grammar, punctuation, and expression when they are 

not simply taught a principle, but when that learning is re-enforced with exercises and with 

application to the students‘ own writing. This can be done with their own writing or reviewing 

their classmates‘ work. Asking students to edit each other‘s writing for grammar, punctuation, 

and usage is another good way to improve their editing skills. This can be done in groups or by 

the whole class editing a paper projected on a screen. 

Some instructors focus highly on sentence combining which is often effective in reinforcing 

skills.  

After a unit of instruction, students could be asked to do a short writing and to apply the skill to 

that writing. Alternatively, students could be asked to edit a draft of a paper they are working on 

for the ENG 101 class for the skill they have just learned. You might run a ―edit the paper‖ 

competition with one of their own papers. As you can see, creativity and flexibility are the keys. 

One of the most common errors you will find involves fragments, run-ons, and comma splices. 

Below are four different methods ALP faculty have used successfully: 

a) An example of a carefully structured plan for teaching the avoidance of fragments, run-

ons, and comma splices: 

o explanation of the concepts of sentence and independent clause  

o practice identifying sentences and independent clauses  

o explanation of fragments and options for correcting them  

o practice in correcting fragments in exercises  

o application of correcting fragments in the students‘ own writing  

o explanation of run-ons and comma splices and ways to correct them  

o practice in correcting fragments, run-ons, and comma splices in exercises  

o application of correcting fragments, run-ons, and comma splices in the students‘ 

own writing 
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Note: Students work first on correcting just fragments. Then, after correcting run-ons and comma 

splices has been introduced, they practice correcting these as well as fragments, first in exercises 

and then in their writing. 

b) Another method of teaching the avoidance of fragments, run-ons, and comma splices 

would be to give them examples with the errors in them, and let the students try to figure 

out what is wrong and identify the errors. 

 

c) A third method is projecting one of their essays (always with their permission) and 

having groups try to identify the errors. 

 

d) Another method, used by Peter Adams, is to give 3x5 cards with a number of sentences. 

He asks them to study the data on the cards (black text is correct; red text contains an 

error) and derive the punctuation rule presented on each card. It provides students the  

opportunity to think about and inductively arrive at punctuation rules.  It is both active 

and cooperative! 

 

The cards each add a new variation to the rules on the preceding cards. When they are 

finished, they will know all the rules for punctuation phrases and clauses that appear 

before an independent clause.  

 

To see more of this and many other grammar exercises go to Appendix D. 
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Technology 

Much information about technology can be found in Appendix E. You may be asking yourself 

why you need to worry about technology. After all, you are an English 

Professor and not teaching Computer Science. The reality is that much of the 

work our students do is on computers. Those students who do not know 

nearly as much are not playing on a level field. It is your job to help ―level 

that field‖. 

Many of your students will let you know that they don‘t have access to a computer. Your best 

friend in that case is the wide availability of computers available to students on each campus. 

 Let your students know the location of computers, printers, and computer labs available 

on your campus. Not having a computer is not an acceptable excuse. 

MyCCBC is the portal to all things CCBC: Blackboard, Grades, Registration, and so on. While 

you may not be spending time on this in class, it is handy to be able to help those who don‘t 

know how to use it. You might consider asking how many of your ALP students know how to 

use it. If there is an issue, you can use this PowerPoint to help them. 

Don‘t assume that your students are familiar with a word processor, using email, saving a 

document, attaching a document, using a flash drive, or other computer tasks. Even if you don‘t 

have a computer in your classroom to help them learn, every class comes with a smart cart which 

you can use to demonstrate. However, almost all of your classes will be in computer rooms. We 

suggest familiarizing your students very early in the semester with whatever they will need for 

your class.  

One problem many students (in the ENGL 101 and ALP 052 sections) have is using spelling and 

grammar checkers. You need to let them know that just because a spell check says that the word 

is spelled correctly doesn‘t mean that it is the right word. Also, many trust grammar checkers as 

the final word. As most of you know, grammar checkers are quite inadequate in many cases. 

In addition, many of your students (ENGL 101 and ALP 052) will not know the difference 

between the style appropriate for writing college essays and the style appropriate for formal and 

informal emails, IM‘s, and text messages, and other casual and/or electronic communication 

mediums (audience awareness).  

Too often students lose their work because they haven‘t backed it up (a problem we are not 

immune to as well). Discuss the necessity of backing up their work on USB flash drives and/or 

on the college SkyDrive which is available for free to all students through their MyCCBC. 

https://ccbcsharepoint/training/it_t/Student%20Portal/myCCBCStudentPortal.pptx
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Explain that ―my dog ate my flash drive‖ is not going to be an acceptable excuse in their college 

careers. 

You probably expect your students to be very web literate, and some are. But you will find that 

many are less so than you‘d expect. Expect to spend some time (in the ALP class and the ENGL 

101) spending time on finding and using information on the World Wide Web. Students need to 

be able to identify what is a good resource and what is not. For example, many believe that a .org 

site is automatically trustworthy. You might want to introduce them to a site such as 

www.martinlutherking.org to demonstrate that .org‘s are not necessarily trustworthy. In addition, 

the school‘s database is a mystery to most of our students. ENGL 101 is a good place to 

introduce it, and the ALP section allows for reinforcement.  

Buster and Assembler  

Buster makes the student‘s job of editing much easier by inserting five lines at the end of each 

sentence. Assembler removes the five lines inserted by Buster, thus re-assembling the essay. 

Created by Peter Adams, Buster and Assembler are available on most computers in English 

classrooms and labs. If Buster is installed, a black and white, checkerboard-like square will be 

visible in the top left portion of the Microsoft Word window. Clicking on this black and white 

icon will cause Buster to run, ―busting‖ apart the essay on the screen. Clicking on the lasso icon 

next to the checkerboard invokes Assembler and re-assembles the essay after proofreading. Note 

that Buster doesn‘t do any actual proofreading; it only makes the student‘s job of proofreading 

easier.  

If these macros aren‘t installed in a classroom or lab you are using, you can ask Instructional 

Technology to install them.  

Buster and Assembler are macros. Macros are used within Microsoft Word so that one keystroke 

can perform a number of functions. You will find that using Buster helps students to an amazing 

degree in finding grammar mistakes, varying sentence length, and being able to edit papers on a 

more specific level.  It is actually exciting to hear students ask each other if they have ―busted 

up‖ their papers yet. 

Students can learn to create these macros that operate on their own computers at home if they are 

using Word 97 or higher. Appendix E to this handbook contains instructions your tech-savvy 

students can use to install Buster and Assembler on their computers at home if they have 

Microsoft Word 2007 installed on their computer. Or you can have students bring lap-tops to 

school and install them, using it as a class lesson. One wording of warning: Microsoft Works 

does not allow Macros, so save yourself the heartbreak and don‘t try to install them. 

 

http://www.martinlutherking.org/
mailto:helpdesk@ccbcmd.edu
mailto:helpdesk@ccbcmd.edu
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Becoming familiar with PowerPoint software is imperative for faculty and students alike. You 

can introduce them to the importance of this application not only by using it in the classroom as 

an instructional tool, but also by explaining the role it has in the worlds of business and industry, 

and/or having them use it in a classroom project. In almost every 101 class, a number of students 

will know how to create PowerPoints and can be used effectively as a teacher resource. 

However, if you need any help, these directions by Microsoft might be of help.  

Here are a few other topics you may want to introduce to your students:  

 The FIND function (use the toolbar or type CTRL + F) on a word processor can be used 

by students to search for the types of errors they find themselves making frequently. For 

example, students who frequently confuse ―then‖ and ―than‖, when editing their writing, 

could use the FIND function to locate and check each use of these words.  

 Green Commas/Black Commas and Red Apostrophes/Black Apostrophes are two 

additional Macros installed on most computers in English computer labs. The first 

enlarges and colors each comma. The second does the same with apostrophes. Each can 

then be returned to its normal state using Black Commas and Black Apostrophes. To run 

Green Commas, the student clicks the green square at the top of the screen. To return 

everything to its original size and color, the student clicks on the green circle or black 

eight ball at the top of the screen.  Again, these can be installed at home by computer 

savvy students, or you can teach them how to do it by demonstrating how to install these 

macros. Once again, remember these will not work if your student doesn‘t have 

Microsoft Word 2007 or more recent. 

 

Affective Issues 

 

What are affective issues and why should you bother dealing with them? Every time one of your 

ALP students is late and says ―I had to take 2 buses‖, you get frustrated. However, initial 

research has shown that developmental students do have to use buses more than credit students 

to come to school. Each time one of your ALP students doesn‘t bring a pen or pencil, it‘s easy to 

forget that fewer of them have had family members or friends who have gone to college. It‘s 

easy to say, ―Why should I have to deal with these types of things? After all, these are college 

students.‖ The answer is that these are students learning to be college students who need all the 

help we can give them. The reward is seeing them graduate and knowing that you were part of it. 

In fact, one of the great advantages of ALP is that it provides time and an opportunity to help 

 

 

http://www.microsoft.com/atwork/skills/presentations.aspx


ALP Handbook 17 

 

 

 
 

 

your students with these issues that you normally would never have time to cover in a traditional 

developmental class.  

 

Sometimes some of these affective issues would best be addressed by a counselor or another of 

the many paid professionals who are there to assist you and your students at CCBC. There is a 

Consultants List in Appendix B. 

 

There are also a number of topics regarding Affective Issues and some suggested teaching 

strategies in Appendix C: 
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Appendix A 

 

List of Possible Writing Assignments 

 

Peter Adams: 

Short Writing: 

Write a short paper, no more than a page double spaced, in which you tell everyone in the class 

one interesting thing you learned about the person you interviewed. Be sure to include concrete 

details to illustrate and support this one thing about the other student. And, of course, be sure to 

include the person‘s name in your paper. 

These papers will be published on the web site, so make sure the other student is comfortable 

with this information being made public. 

 

Short Writing: Lying 

This is a short writing designed to give you an opportunity to really do some thinking. I hope 

you‘ll put some serious thought into this question: when is it okay to lie? How can you subdivide 

this topic the way we did on the ―parking‖ paper in class? 

For this assignment, I‘d like you to write a short paper, no more than a page double spaced, in 

which you tell everyone in the class what you have decided, after some serious thinking, about 

the question of when it is okay to lie. 

 

Short Writing: Definitions 

This is a short writing designed to give you practice at writing definitions. For this assignment, 

I‘d like you to write three paragraphs, each defining one of the following words: 

 word 

 name 

 verb 

 event 

 obscenity 
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Peter Adams: This is a short writing designed to give you practice at writing definitions. For 

this assignment, I‘d like you to write three paragraphs, each defining one of the following words: 

automobile 

name 

sentence 

event 

obscenity 

mammal 

Or, for those who are feeling really adventurous, try defining the word ―word‖ as one of your 

three. 

Short Writing: Why Are You in a Basic Writing Course? 

You arrived at CCBC and were assessed as needing a basic writing course to get you ready to do 

college-level writing. There are probably a number of reasons why you were placed in basic 

writing. Write a short essay in which you explain to me what the different factors were that led to 

your arriving at CCBC and being placed in this course. 

Short Writing : 

I would like you to write a one-page essay in which you tell me about someone you know who 

has worked hard and has gotten ahead. What did they do that was such hard work? In what way 

have they ―gotten ahead‖? Give concrete examples of how hard they worked. Provide evidence 

that they have actually ―gotten ahead.‖ 

Short Writing: 

I would like you to write a one-page essay in which you tell me about someone you know who 

has worked hard, but has not gotten ahead. What did they do that you consider ―working hard‖? 

How do you know they haven‘t ―gotten ahead‖? 

Short Writing: Mini-Bios 

In class, you will be paired with another student whom you will interview and who will 

interview you. Your goal in this interview is to find one interesting thing (the more interesting, 

the better) about the other student and some examples that illustrate this interesting thing. It 

would be a good idea to take notes as you conduct the interview. 
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Peter Adams: Short Writing:  

 

The chart represents the chances a student has of being placed in developmental courses 

depending on his or her family income.  

 

 
 

Write a short paper in which you discuss two things:  

 

1. What do you conclude about the relationship between developmental education 

placement and family income? 

 

2. Explain what the causes of this relationship might be. 

 

 

Short Writing Assignment:   
                   

Here are three true stories: 

1. A young woman from a poor family in Richmond, Virginia, won a scholarship to study at 

a very expensive university in Cambridge, Massachusetts. When she returned home at the 

end of the first semester, her mother was fixing a big dinner to celebrate her success. The 

mother said to her daughter, ―Dinner won‘t be ready for another hour. Why don‘t you lay  
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down and rest for a while. I‘ll call you when dinner is ready.‖ The daughter replied, ―You 

mean ‗lie down.‘‖ Her father jumped up from his chair and, for the first time in her life, 

slapped his daughter across her face. ―Don‘t ever correct your mother‘s grammar again,‖ 

he said. 

 

2. Bruce Rose, an African-American student at the University of Massachusetts lived in the 

dorm where I was resident assistant while I was in grad school. Bruce loved going to 

college, but was also looking forward to returning to his home in New Bedford for the 

summer. The next September, when he returned to the dorm, I asked him how his 

summer had been. He replied, ―Fine. But I had a little trouble fitting back in with my 

friends. They kept telling me I was ‗putting on airs.‘ They said I was ‗turning into a snob 

because of the way I talked‘‖. 

 

3. About two weeks into the semester a student in ENG 052 waited to talk to the instructor 

at the end of class. ―I won‘t be coming back,‖ he said. ―I‘m dropping out of school.‖ The 

concerned teacher asked why. The student replied, ―I don‘t want to be like you people.‖ 

 

For this short writing, discuss what these three stories have in common. Do some real thinking 

before you start writing. 
  
Length: 1 to 1 ½ pages; typed and double spaced. 
 

Peter Adams: An interesting exercise on critical thinking. 

 

Linda De La Ysla – A very interesting questionnaire short write. 

 

Dear Student: 

I will be giving a conference presentation this summer about our work this semester in the ALP 

program.  Because many other colleges and universities around the country are interested in the 

CCBC ALP Program, some of the faculty here will be sharing theirs and their students‘ 

impressions at the Baltimore Conference on Acceleration June 23-25.  If you would take some 

time today to answer these questions in as much detail as possible, I would appreciate it very 

much.  However, your participation is entirely voluntary, and will not affect your grade in any 

way.  (If you wish to remain anonymous, I will not include your name.) The audience for my 

presentation will be college writing professors and administrators.  Thank you!   

 

#1:  How strong a writer were you when you began the ALP course?  Have you improved, stayed 

the same, or gotten worse over the past 15 weeks?   

 

#2:  What helps you the most as a writer?   What helps the least? 

http://faculty.ccbcmd.edu/~padams/00%20spring%202011/101/Ex3Development.html
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#3: Briefly describe a time when Professor De La Ysla sat down with you one-on-one to go over 

a paper:  

 

 

A Letter to Yourself 

1)  Address an envelope to yourself, using an address that will be valid in about 5 months; 

write ―Confidential‖ on the front of the envelope, if you are concerned that someone else 

might open it. 

 

2) Now … write a letter to yourself, expressing a hope, dream, or prayer for where you want 

to ―be‖ in 5 months. 

 

 

3) I will send this letter to you at the end of next semester! 

 

Peter Adams: Essay 

a) An excellent assignment on racism. It also deals with audience awareness 

b) An essay on – What is Art? It should lead to some excellent class discussion. Use in 

101 or 052 

Fawcett Dunstan: Module 1: Writing Process Practice 

Introduction, Thesis, Topic Sentence, Concluding Sentence, & Conclusion 

Learning Goals & Objectives: 

After completing this module, you will be able to understand what a strong thesis statement 

looks like. 

You will be able to: 

4. Identify a strong introductory lead-in.  Understand how to write a clear thesis and know 

where to place it in your essay 

5. Identify and understand topic sentences in paragraphs 

6. Understand how a concluding sentence is used at the end of body paragraphs 

7. Understand ways to write a conclusion  

8. Module Introduction: 

http://faculty.ccbcmd.edu/~padams/00%20spring%202011/101/Paper3.html
http://faculty.ccbcmd.edu/~padams/00%20spring%202011/101/Paper%204%20what%20is%20art.html
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Introduction  

Lead-in or Hook: 

The first paragraph of your essay is called the introduction, and it should include at least one or 

more sentences before the thesis statement, which is the last sentence of the introduction.  These 

sentences should grab the reader‘s attention.  They are known as the lead-in or the hook because 

they should be interesting enough to hook your reader  

to the topic.  Some ideas for engaging the reader include asking a question, using a relevant 

quote and showing how it is related to your topic, or offering a short anecdote or narrative that 

relates to your topic.   

 

Lead-in or hook example: 

 

A writer once said, ―A man finds his identity by identifying.‖  There are many things in my 

wallet that identify me as a thrifty person.  I have many receipts from discount stores, loyalty 

store cards, and coupons that I painstakingly cut out every week.   

 

Thesis Statement  

Your introduction should end with a thesis statement. (While your thesis statement can 

theoretically be anywhere in your essay, it is easier for your readers if you make it the last 

sentence of your introduction. In fact, I will require that you place your thesis statement in the 

last line of your introduction.) In a nutshell, your thesis statement is the point (or opinion) you 

make about your topic. It is a sentence that should contain the following formula: 

topic (subject of paper) + your opinion about your topic = thesis statement 

Thesis example: 

My personal identity is clearly evident in the contents of my wallet.   

Topic = my personal identity + your opinion = evident in the contents of my wallet 

 

Topic Sentence 

Each of your body paragraphs should contain a topic sentence, which is the main idea of your 

paragraph.  It is generally preferred that your topic sentence be placed in the first line of your 

paragraph so that the reader can quickly identify the paragraph‘s main idea.   

 

Topic sentence example: 

One of the main things in my wallet that identifies me as a thrifty person is the amount of 

receipts that I have from discount stores.  
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Concluding Sentence 

Your concluding sentence should not be confused with your conclusion, which is the closing 

paragraph of your essay.  Your concluding sentence is a brief sentence summary at the end of  

each paragraph.  As mentioned in English 101, you do not want to make a point in your 

paragraph and then leave the readers hanging.  A brief sentence summary at the end of your 

paragraph will help your readers understand the point you are trying to make.   

 

Concluding sentence example: 

Because of the many receipts from discount stores spilling over in my wallet, an observer would 

quickly guess that I am very thrifty.   

 

Conclusion 

Your conclusion is the last paragraph of your essay and it should bring closure to your essay.  

The easiest way to close your essay is by restating your thesis using slightly different words.  

Another way to close your essay is to  

summarize the main points of your essay.  Still another way to close your essay is to offer your 

final thoughts on the subject.   

 

Conclusion example: 

Not too many people will doubt my thrifty identity after they have had a chance to peek into my 

wallet and see the bountiful receipts from discount stores, the ample collection of loyalty store 

cards, and vast reservoir of coupons for all kinds of items.   

 

Readings for this Module: 

Writing First:  Writing an Essay, pp. 145-147; Sample Essay, pp. 147-148 

 

Homework for this Module: 

 Read the practice 12-1 sample essay on p. 149.  Send me an email to the answers on pp. 149-

150. 

Learning Activities 

 

1. Click on grammar-quizzes.com to take the quiz on different types of introductions (or lead-

ins). 

2. Click on http://grammar-quizzes.com/thesis_sent.htmlto take the quiz on thesis.  

 

 

Monica Walker: Accelerated Learning Project Course – Midterm Survey  

 

a) At this point, how are you feeling about your experience in English 101/052 

Accelerated Learning Project (positive, neutral, negative)? Explain your response.  

http://www.grammar-quizzes.com/intros.html
http://grammar-quizzes.com/thesis_sent.html
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b) Which writing concepts that we‘ve discussed thus far have you found most 

helpful?  

 

c) As your instructor, how can I assist your continued growth & development as a 

writer in the remaining seven weeks of class?  

 

d) Is there anything in particular about writing that you hope we will cover before 

the end of the course? If so, please explain.  

 

 

Annemarie Chiarini 

 

Once again, we have an essay that works in 101 or 052.  

Choose one of your favorite foods and find one of the ingredients. Write a short essay that 

discusses the following: 

  

-          the ingredient‘s history 

-          how widely the ingredient is used 

-          is the ingredient dangerous in any way 

-          how is the ingredient made. 

  

Also, is there anything else that you can tell me about it? For example, has it changed your 

opinion of the food? 

 

Be sure to cite your documentation. 

A minimum of two sources. 

 

Peter Adams: Here you will find a number of links to exercises and videos for topics ranging 

from MLA to punctuation. Feel free to use them for your class or let them inspire you to create 

your own. 

 

 

 

 

 

 

 

 

 

 

 

http://faculty.ccbcmd.edu/~padams/00%20spring%202011/101/ClassDocs101.html
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Appendix B 
 

Roster of Consultants Available to Work with ALP Students 

 

 

Table 1: Organized by Topic 

topic Catonsville Dundalk Essex 

academic advice Sigmon, Bill; Marlene 

Radich 

Caesar, Sonya Adams, Joy 

balancing work and school Williams, Mark Caesar, Sonya Zlotowitz, Harriet;  

behavior/attitude Williams, Mark; Messier, 

Larry; Epps, Zabrina; 

Pemberton, Jennifer 

Caesar, Sonya Smith, Ileane; Zlotowitz, 

Harriet; Brothers, Linda 

career advice Williams, Mark; 

Pemberton,  Jennifer 

Caesar, Sonya Brothers, Linda; Monica 

Walker;Nancy Shualy 

family problems Messier, Larry; 

Pemberton, Jennifer 

Caesar, Sonya  

financial aid Lovick, Jerome; Bowler, 

Margaret; Gay, Mark 

Gay, Mark Amos, Barry 

financial problems Aaronson, Larry; Gandy, 

Kathleen 

Caesar, Sonya Amos, Barry 

health/medical issues  Caesar, Sonya  

legal problems Grimes, Meisha Caesar, Sonya Washington, Eric 

stress management Pemberton, Jennifer Caesar, Sonya  

study skills Williams, Mark; Messier, 

Larry; Epps, Zabrina 

Griner, Heather; Caesar, 

Sonya 

Topolski, Courtney;  

test taking Williams, Mark; Messier, 

Larry; Epps, Zabrina 

Griner, Heather; Caesar, 

Sonya 

Topolski, Courtney;  

time management Williams, Mark; Messier, 

Larry; Radich, Marlene; 

Pemberton, Jennifer 

Griner, Heather; Caesar, 

Sonya 

Hervey, Martha; 

Zlotowitz, Harriet;  

transportation problems  Caesar, Sonya  

Veterans Affairs Gay, Mark   

Developmental education 

policies (repeat attempts) 

Baird, Nicole Caesar, Sonya Adams, Joy 
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Table 2: Organized by Consultant Names 

name campus email phone 

Aaronson, Larry C laaronson@ccbcmd.edu 

 

443-840-5314 

Bowler, Margaret C mbowler@ccbcmd.edu 

 

443-840-4170 

Brothers, Linda E lbrothers@ccbcmd.edu 

 

443-840-1715 

Caesar, Sonya D scaesar@ccbcmd.edu 

 

443-840-3455 

Delker, Susan D sdelker@ccbcmd.edu 

 

443-840-2004 

Epps, Zabrina  C Zepps@ccbcmd.edu 

 

443-840-4921 

Gandy, Kathleen C Kgandy@ccbcmd.edu 

 

443-840-4205 

Gay, Mark D mgay@ccbcmd.edu 

 

443-840-4705 

Hervey, Martha E mhervey@ccbcmd.edu 

 

443-840-1385 

Adams, Joy E jadams4@ccbcmd.edu 

 

443-840-1473 

Joyner, Jennifer E Jjoyner@ccbcmd.edu 

 

443-840-1469 

Lovick, Jerome C JLOVICK@ccbcmd.edu 

 

443-840-4706 

Messier, Larry C lmessier@ccbcmd.edu 

 

443-840-4724 

Radich, Marlene C MDRadich@ccbcmd.edu 

 

443-840-4909 

Pemberton, Jennifer C jpemberton@ccbcmd.edu 

 

443-840-4323 

Sigmon, Bill C wsigmon@ccbcmd.edu 

 

443-840-4912 

Smith, Ileane E ismith@ccbcmd.edu 

 

443-840-1337  

Topolski, Courtney E ctopolski@ccbcmd.edu 

 

443-840-1905 

Washington, Eric E Ewashington@ccbcmd.edu 

 

443-840-2108 

Williams, Mark C mwilliams@ccbcmd.edu 

 

443-840-4334 

Zawodny, Ginny E gzawodny@ccbcmd.edu 

 

443-840-1936 

Zlotowitz, Harriet E hzlotowitz@ccbcmd.edu 

 

443-840-1384 

Walker, Monica E mwalker@ccbcmd.edu  443-840-1988 

mailto:laaronson@ccbcmd.edu
mailto:mbowler@ccbcmd.edu
mailto:lbrothers@ccbcmd.edu
mailto:scaesar@ccbcmd.edu
mailto:sdelker@ccbcmd.edu
mailto:Zepps@ccbcmd.edu
mailto:Kgandy@ccbcmd.edu
mailto:mgay@ccbcmd.edu
mailto:mhervey@ccbcmd.edu
mailto:jadams4@ccbcmd.edu
mailto:Jjoyner@ccbcmd.edu
mailto:JLOVICK@ccbcmd.edu
mailto:lmessier@ccbcmd.edu
mailto:MDRadich@ccbcmd.edu
mailto:jpemberton@ccbcmd.edu
mailto:wsigmon@ccbcmd.edu
mailto:ismith@ccbcmd.edu
mailto:ctopolski@ccbcmd.edu
mailto:Ewashington@ccbcmd.edu
mailto:mwilliams@ccbcmd.edu
mailto:gzawodny@ccbcmd.edu
mailto:hzlotowitz@ccbcmd.edu
mailto:mwalker@ccbcmd.edu
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name campus email phone 

Baird, Nicole C nbaird@ccbcmd.edu 443-840-2754 

 

Griner, Heather D hgriner@ccbcmd.edu  443-840-3774 

 

Amos, Barry D BAmos@ccbcmd.edu 443-840-3088 

Grimes, Meisha C mgrimes@ccbcmd.edu 443-840-4025 

Shualy, Nancy E nshualy@ccbcmd.edu 443-840-1440 

 

*Note: This list may not be up to date. After all, people come and go each semester. However, if 

someone is no longer there, ASK! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

mailto:nbaird@ccbcmd.edu
mailto:hgriner@ccbcmd.edu
mailto:BAmos@ccbcmd.edu
mailto:mgrimes@ccbcmd.edu
mailto:nshualy@ccbcmd.edu
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Appendix C 

 

Dealing with Affective Issues 

 

Time Management 

 

a) For one week, keep a journal with daily entries.  There should be multiple entries for each 

day. 

   

b) Prioritize activities to your highest priority activities.  Ask the question, ―What is the very 

best use of my time right now?‖ 

 

Describe what you were doing, then how you became aware of what you were doing that 

yourself. 
 

c) Bob Miller has a student who is having problems come to the board and then the student 

makes a chart with his or her daily obligations. The entire ALP class helps the student to 

make a schedule in order to find time for studying or doing assignments. This gets 

students thinking about their own schedules. It also points out how many of our students 

are taking too much on themselves by taking too many classes and/or working too many 

hours. 

 

d) Here is a link to a separate pdf file time management tutorial.  

 

e) Susan Gabriel has provided a link to a time management chart which leads to a cool 

interactive chart that allows students in enter the number of hours they spend on various 

activities—each time they put in hours, the chart subtracts those hours from 24. She had 

her students do the chart on-line for a week; they then compared the number of hours 

each of them spent on the listed activities and discussed how they could better use their 

24 hours each day. The students loved it. 

 

 

 

Motivation – Many of our students have little self-confidence (even if it is covered up by bluster 

and apparent inflated self-confidence). Here are a few classroom techniques that you might find 

interesting: 

 

a) Susan Gabriel has sent us this document relating to motivation and long-range planning 

activity. It‘s a series of questions that ask students to look ahead to their long-term goals 

 

http://faculty.ccbcmd.edu/~hzlotow1/Time_Management.pdf
http://www.studygs.net/schedule/
http://facultypedagogygroup.wikispaces.com/file/view/Motivation+%26+Long-Range+Planning.doc
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as well as to focus on their short-term goals for the class and their semester at CCBC. She 

uses this to serve as the basis for a short paper called, ―It‘s All About Me,‖ which is 

available with the link just below. She uses this assignment as a way of letting the 

students get to know each other and also as a way to introduce essay structure. Susan says 

that the students have liked the assignment, even the part where she has them give an 

informal oral presentation about themselves. In the past, she used this assignment only in 

my ALP section not in the 101 class but is thinking to use it in both sections. 

 

 

b) This chart shows students the relationship between level of education and salary, and also 

unemployment rate. It provides good information to motivate students to stay in school. 

 education vs income chart.docx 

 

c) Click this link to view a Motivation lesson that Monica Walker has conducted with her 

ALP classes that incorporates the classroom clickers. Monica writes "In so doing, I poll 

my students on the second day of class to learn more about their perceptions about 

writing myths and to offer them a reality check on what they can expect as academic 

writers. This activity lends itself to great discussions and students really become engaged 

as they voice their opinions through anonymous voting. Some of the myths that I dispel 

through this activity include the fact that good writers write quickly and do not have to 

revise. I also encourage ALP students to begin to view themselves as writers and to 

consider reasons why they might become distracted and prone to procrastinate. Let me 

know what you think of this activity." 

 

d) Bob Miller sends us this poll of business leaders' views of how well college graduates are 

prepared for the business world. 

 

 

Transportation  

  

As stated early, many of our ALP students have to take 2 or 3 buses to get to school. Susan 

Gabriel sends us a link to an MTA website with info on a reduced price monthly bus pass for 

college students. These passes are available at the bookstores on the three campuses. 

 

 

Health  

 

Many of your students will run into health issues that normally will cause them to drop your 

class. Some will feel too embarrassed to come back if they miss two or three classes, thinking 

that you will be angry with them. Try to set up good lines of communication early in the 

http://facultypedagogygroup.wikispaces.com/file/view/Motivation+%26+Long-Range+Planning.doc
http://facultypedagogygroup.wikispaces.com/file/view/education+vs+income+chart.docx
http://facultypedagogygroup.wikispaces.com/file/view/Motivation+Lesson+from+Monica.pdf
http://facultypedagogygroup.wikispaces.com/file/view/BusinessLeadersonStudentPreparedness.pdf
http://facultypedagogygroup.wikispaces.com/file/view/BusinessLeadersonStudentPreparedness.pdf
http://mta.maryland.gov/fares/specialprograms/collegepass.cfm
http://facultypedagogygroup.wikispaces.com/file/view/education+vs+income+chart.docx
http://facultypedagogygroup.wikispaces.com/file/view/education+vs+income+chart.docx
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semester. It helps if students have traded email and cell phone numbers, so they can be your first 

line of defense in understanding why a student has missed class/es. Reach out to the students so 

they know they are still welcome. 

 

Thanks to Harriet Zlotowitz from CCBC Essex Career Services for sharing the following 

materials with us. 

a)  Click here for a web site filled with useful info about mental health. 

b) You Tube video on how to get an "A" in any class: 

http://www.youtube.com/watch?v=HSVmgTLwUC4 

c) Reasons for seeking counseling: 

http://www.ccbcmd.edu/counseling/clinical_counseling/Topics.html 

d) How faculty can make a referral: 

http://www.ccbcmd.edu/counseling/clinical_counseling/how_to_refer_guide.html 

Finances:   

Many ALP students have a lack of understanding of the financial aid process; in fact, a number 

of eligible students do not apply because they don‘t know or are intimidated by the process. In 

order to better help your students, it is good to have a basic understanding yourself. To help you 

understand the processes of financial aid on campus, please view The Faculty Quick Guide to 

Financial Aid. 

You may have a student who says (honestly) that he or she cannot afford your text books. There 

are places where students can get short term quick grants, for example $50, to help with books or 

other problems. This is run by the CCBC Foundation Board, and there is no complete list as of 

yet. Therefore, the best thing you can do is send the student to the financial aid office on your 

campus to see if there is any help available. 

Promoting Successful Student Behavior 

As stated earlier, your syllabus should include clear policies on attendance, plagiarism, and 

inappropriate use of electronics including MP3s, cell phones, computers, and text messaging. 

However, stating your policies in a syllabus is not enough. These topics need to be revisited 

throughout the semester. Note: CCBC has a firm policy that students must turn their cell phones 

to vibrate in class. 

One of the most successful strategies is getting to know each student‘s name early in semester, 

and this is fairly easy because you only have 8 students in the section. Moreover, in an ALP class 

it is very helpful for students to learn each others‘ names early in semester as well. Successful 

ALP faculty will have them trade email addresses and/or cell numbers, so if a student misses  

http://www.dr-bob.org/vpc/virtulets.html
http://www.youtube.com/watch?v=HSVmgTLwUC4
http://www.ccbcmd.edu/counseling/clinical_counseling/Topics.html
http://www.ccbcmd.edu/counseling/clinical_counseling/how_to_refer_guide.html
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class, he or she can get in touch with classmates. It is helpful to remind them that some of their 

classmates may become precious resources later in their college career or life. 

 

Social Behaviors:  

 

There are a number of strategies for dealing with students not paying attention during class. 

These can be extremely frustrating to the ALP teacher in a class of 8 students. Rather than 

becoming confrontational, we suggest you try some of the following: 

 

a) Excessive talking or side conversations: 

 Ask them to share their ideas on the topic that‘s being discussed  

 Ask them a question about what‘s being discussed  

 Move toward the talkers  

 Make eye contact with them  

 Comment to the entire class that there should be ―only one speaker at a 

time‖  

 Stop and wait until side talking subsides  

 Tell students early in semester that to get the class‘s attention you will 

stop talking and raise your hand and that this is your signal for the other 

students to also stop, raise a hand, and stop talking 

 Divide and conquer: Separate students who tend to sit together in talkative 

groups by dividing the entire class into small discussion groups, putting 

the talkative students into groups without their friends and assigning each 

member of the group a role where s/he is responsible to report back to the 

class what took place in the group.  

b) Strategies for dealing with cell phone usage and text messaging:  

 Make a broad announcement to class reminding them of your policy  

 Talk to students privately and remind them of the consequences of cell 

phone usage as it is stated in your syllabus. 

 Remind students that if there is an emergency situation to ask ahead of 

time to keep cell phones on. 

  

c) Strategies for dealing with students using Facebook or email while on computers: 

 Make a broad announcement to class reminding them of your policy  

 Talk to students privately and remind them of the consequences of 

inappropriate use of electronics as it is stated in your syllabus.  
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d) Strategies for dealing with inappropriate language: 

 Give students chance to rephrase their words by saying ―I‘m sorry, I didn‘t 

hear what you said‖  

 Remind students privately about your etiquette policy and the 

consequences of not abiding by that policy 

e) Strategies for dealing with students sleeping in class: 

 Move toward the student and call the student‘s name.  

 Call the student by name to ask a question  

 Privately ask the student about sleeping habits and diet to see if there is a 

root cause to be addressed  

 Suggest that the student get a drink of water 

f) Strategies for dealing with students not paying attention: 

 Call on the student by name to answer a question  

g) Strategies for dealing with aggressive or hostile behaviors/arguing : 

 Redirect a student‘s arguments back to the class in question form  

 Remain calm and polite and never show anger back  

 Don‘t be confrontational  

 Speak to the student privately about classroom behaviors/expectations and 

try to find out what is behind the behavior. 

 Consult your coordinator 

 Contact a Judicial Affairs Advocate  

a) Essex – Eric Washington – 443-840-2108 

b) Dundalk: Lori Meehan – 443-840-3782 

c) Catonsville (Owings Mills/Hunt Valley): Charolene Oliver 443-

840-4130 

 Fill out an Incident Report if you feel this should be officially 

documented. 

 Privately ask the student not to return to class unless she or he agrees to 

follow your classroom etiquette policy. The student then needs to meet 

with you privately to discuss behavior prior to returning to class. 

HOWEVER, if you are ever feeling directly threatened, immediately contact Public Safety. 

There are buttons for public safety where you turn the overhead on and off. You can also reach 

them at these numbers for emergencies only:  

Essex – 443-840-1893 Catonsville -  443-840-4258  Dundalk -  443-840-3200 

https://publicdocs.maxient.com/incidentreport.php?CCofBaltimoreCounty
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h) Strategies for dealing with whining/complaining  

 Examine whether the complaint is legitimate.  

 Be sympathetic, but firm in your expectations.  

 If it‘s important to your class, stand your ground and explain that your 

policy is not negotiable. 

 If you can negotiate, then ask the student what she or he would like the 

outcome to be.  

 Ask ―what can I do to help?‖ and then, after listening to student‘s ideas, 

ask the student what he or she can do to improve situation. 

 Meet the student in your class and have a discussion. 
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Appendix D:  

Sample Classroom Activities for ALP 052  

ALP In-class Grammar and Punctuation Activities  

Cheryl Scott 

I use these activities frequently to help the students identify and correct grammar and 

punctuation as it relates to the specific area of grammar we are working on.  

After I correct students‘ papers, I go through and find sentences from each paper with a specific 

error, for example, comma splices and run-ons, that I know we will be working on in the next 

class. I then use their own sentences to make grammar work sheets for them.  

I have also used entire paragraphs from the students‘ own papers to talk about paragraph 

development or sentence variety or structures.  

Also, when I return the students‘ graded papers, I will indicate that they have errors in specific 

paragraphs, but I won‘t tell them what the errors are. I put them into groups and have them 

identify, for example, all the run on and comma splices errors they made and have them correct 

the errors, and we either put them on the board or type them on the overhead and discuss how to 

correct them.  

I think these activities serve several purposes. They help students learn how to edit their own 

papers making it more relevant as they use their own work rather than sentences that have no 

meaning to them. Therefore, they are just not working on grammar; they are actually revising 

their own work. I think it also shows them how important it is to have another person read their 

work in the revision process. Finally, it highlights for the student the areas of grammar where 

they most often make errors and gives them practice in identifying these frequent errors and 

strategies for correcting them in the context of their own paragraphs. They come to realize that 

there are many ways, for example, to correct comma splices and they need to choose the way 

that works best for their purpose.  

Believe it or not, the students actually enjoy these kinds of activities and will even seem insulted 

if I don‘t use one of their sentences.  
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Pat Rennie 

Recognizing Compound Sentences and Adding Commas  

 Circle any fanboys (for, and, nor, but, or, yet, so)  

 Read the phrase before the fanboys and decide if it could stand alone as a complete 

sentence  

 Read the phrase after the fanboys and decide if it could stand alone as a complete 

sentence  

 Add commas only where they are needed  

 Do not add any words  

1. I came to see the play but the theater was closed.  

2. The waiter at the crowded restaurant rushed from table to table and tried to please the 

impatient customers.  

3. Before my trip I read everything in the library about Puerto Rico and I took a Spanish class in 

night school.  

4. The young couple is planning to save their money and is hoping to buy a small house in the 

suburbs.  

5. It rained all weekend so the picnic was postponed.  

6. Rosa showed signs of nervousness in her speech yet her words carried conviction and power.  

7. I looked in three stores for the perfect birthday gift for Fred but couldn‘t find anything at all.  

8. You have to prepare for a marathon or you can do serious damage to your body.  

9. She deserved to win first prize for she had spent years practicing her skills.  

10. The customers were not interested in my excuses nor were they sympathetic with my 

problems.  
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Peter Adams 

Inductive Exercise for Learning - the Punctuation Rules for Introductory Elements 

The following can be printed on 3 X 5 cards which can be passed out to students, one card at a 

time.  Ask them to study the data on the cards (black text is correct; red text contains an error) 

and derive the punctuation rule represented on each card. 

 

The cards each add a new variation to the rules on the preceding cards.  When they are finished, 

they‘ll know all the rules for punctuating phrases and clauses that appear before or after an 

independent clause. 

  

Commas: 

 
1.  What can you figure out about comma rules from the following sentences?  The sentences in black are 

correct; the sentences in red contain a comma error. 

__________________________________________________ 
When I answered the phone, no one was there. 

When I answered the phone no one was there. 

If it rains tomorrow, I will stay home and study. 

If it rains tomorrow I will stay home and study. 

When Jessica woke up, she had a terrible headache. 

When Jessica woke up she had a terrible headache. 

Because I work forty hours a week, I never have time for hanging out. 

Because I work forty hours a week I never have time for hanging out. 

Since I grew up in the city, I don‘t know much about raising animals. 

Since I grew up in the city I don‘t know much about raising animals. 

 

2.  What can you figure out about comma rules from the following sentences?  The sentences in black are 

correct; the sentences in red contain a comma error. 

_____________________________________________________________________ 

 
Running after the bus, Matt sprained his ankle. 

Running after the bus Matt sprained his ankle. 

Watching television last night, Chris saw someone he knew. 

Watching television last night Chris saw someone he knew. 

Looking for a sock, Andrew found a twenty dollar bill. 

Looking for a sock Andrew found a twenty dollar bill. 

Hoping for a B, Erica was surprised that she got an A on the test. 

Hoping for a B Erica was surprised that she got an A on the test. 

Looking at the gradebook, Jessica noticed a mistake. 

Looking at the gradebook Jessica noticed a mistake. 
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3.  What can you figure out about comma rules from the following sentences?  The sentences in black are 

correct; the sentences in red contain a comma error. 

_____________________________________________________________________ 
 

In the morning, Jack felt much better. 

In the morning Jack felt much better. 

On the top of the refrigerator, I found a set of keys. 

On the top of the refrigerator I found a set of keys. 

Near the sub shop where I work, there was a holdup yesterday. 

Near the sub shop where I work there was a holdup yesterday. 

At the end of the movie, Peter started crying. 

At the end of the movie Peter started crying. 

With the help of her sister, Jasmine got a great job. 

With the help of her sister Jasmine got a great job. 

 
4.  What can you figure out about comma rules from the following sentences?  The sentences in black are 

correct; the sentences in red contain a comma error. 

_____________________________________________________________________ 
 

Running after a bus can be dangerous. 

Running after a bus, can be dangerous. 

Whoever finishes the exam first should go tell the teacher. 

Whoever finishes the exam first, should go tell the teacher. 

Leaving a small tip was not fair to the server. 

Leaving a small tip, was not fair to the server. 

In the morning is when we are leaving for vacation. 

In the morning, is when we are leaving for vacation. 

Texting in class can get you in trouble. 

Texting in class, can get you in trouble. 

 
5.  What can you figure out about comma rules from the following sentences?  The sentences in black are 

correct; the sentences in red contain a comma error. 

_____________________________________________________________________ 
 

I will call you when I arrive in New York. 

I will call you, when I arrive in New York.  

We were late for class, because of a traffic jam on the Beltway. 

We were late for class because of a traffic jam on the Beltway. 

Matt sprained his ankle running after the bus. 

Matt sprained his ankle, running after the bus. 

Andrew found twenty dollars looking for his sock. 

Andrew found twenty dollars, looking for his sock. 

Andrew saw a man looking for a taxi. 

Andrew saw a man, looking for a taxi. 
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Punctuation: 
1.  What can you figure out about punctuation rules from the following sentences?  The sentences in black 

are correct; the sentences in red contain a punctuation error. 
__________________________________________________ 

I meant to pay my rent yesterday; however, I forgot to mail the check. 

I meant to pay my rent yesterday, however, I forgot to mail the check. 

I meant to pay my rent yesterday; however I forgot to mail the check. 

 
Mark studied very hard; nevertheless, he failed his midterm in math. 

Mark studied very hard, nevertheless, he failed his midterm in math. 

Mark studied very hard; nevertheless he failed his midterm in math. 

 
Peter was sick last week; as a result, he cancelled class. 

Peter was sick last week, as a result, he cancelled class. 

Peter was sick last week; as a result he cancelled class. 

 
2.  What can you figure out about punctuation rules from the following sentences?  The sentences in black 

are correct; the sentences in red contain a comma error. 
__________________________________________________ 
My math teacher gave us a quiz. I think I did well on it. 

My math teacher gave us a quiz, I think I did well on it. 

Today is Vivaldi‘s birthday.  He would be more than 300 years old. 

Today is Vivaldi‘s birthday, he would be more than 300 years old. 

I don‘t have time to go to a movie.  I have to write a paper for English class. 

I don‘t have time to go to a movie, I have to write a paper for English class. 

I was offered a job in Hunt Valley.  I would rather work in the city. 

I was offered a job in Hunt Valley, I would rather work in the city.  

 

3.  What can you figure out about punctuation rules from the following sentences?  The 

sentences in black are correct; the sentences in red contain a punctuation error. 
__________________________________________________ 
My mother visited many interesting countries, for example, Indonesia and Japan. 

My mother visited many interesting countries; for example, Indonesia and Japan. 

My mother visited many interesting countries for example, Indonesia and Japan. 

 

Shania‘s salad had some unusual ingredients, for instance, arugula, frisse, and fennel. 

Shania‘s salad had some unusual ingredients; for instance, arugula, frisse, and fennel. 

Shania‘s salad had some unusual ingredients for instance, arugula, frisse, and fennel. 

 

If you are absent, however, you get zero points for that class. 

If you are absent; however, you get zero points for that class. 

If you are absent however, you get zero points for that class. 
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4.  What can you figure out about punctuation rules from the following sentences?  The 

sentences in black are correct; the sentences in red contain a comma error. 
__________________________________________________ 
Peter discussed punctuation rules and gave us some 3 X 5 cards to study. 

Peter discussed punctuation rules, and gave us some 3 X 5 cards to study. 

My mother has worked hard all her life but has not gotten ahead because of it. 

My mother has worked hard all her life, but has not gotten ahead because of it. 

La‘Quasia opened the door and let a strange cat into the house. 

La‘Quasia opened the door, and let a strange cat into the house. 

Maria wants to take English 102 in the summer or to take it in the fall. 

Maria wants to take English 102 in the summer, or to take it in the fall. 

 

5.  What can you figure out about punctuation rules from the following sentences?  The sentences in 

black are correct; the sentences in red contain a punctuation error. 
__________________________________________________ 
Jamard learned one thing today; it is important to do homework. 

Jamard learned one thing today; the importance of doing homework. 

La Quasia searched for the answer on the internet; she didn‘t find it. 

La Quasia searched for the answer on the internet; but didn‘t find it. 

Jessica looked for her phone; she found it in her purse when it started ringing. 

Looking for her phone; Jessica found it in her purse when it started ringing. 

Cristine read a chapter in her psychology text; she still didn‘t understand Maslow‘s heirarchy. 

Even though Cristine read a chapter in her psychology text; she still didn‘t understand Maslow‘s heirarchy. 

 

Punctuation and Capitalization:   What can you figure out about punctuation and capitalization rules from 

the following sentences?  The sentences in black are correct; the sentences in red contain an error. 

__________________________________________________ 

 
Maria didn‘t sleep at all last night; she was studying for a test in her math class. 

Maria didn‘t sleep at all last night; She was studying for a test in her math class. 

Maria didn‘t sleep at all last night she was studying for a test in her math class. 

Maria didn‘t sleep at all last night, she was studying for a test in her math class. 
 

I hate word problems in math class; they are always too tricky. 

I hate word problems in math class; They are always too tricky. 

I hate word problems in math class they are always too tricky. 

I hate word problems in math class, they are always too tricky. 

 

_________________________________________________ 
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Anne Roberts 

This exercise is an effort to get students to understand the role of word choice in shaping tone, 

mood, sense, and so on. As a rule I want them to be aware of word choice as early in the 

semester as possible, so they sense the power of their own voice and their role as 

editor/interpreter. I especially work with them on verb choice, asking them to strive for livelier 

language, verbs suited directly to the context.  

JOURNAL WORK: Start by asking them to think about their actions that morning. Sometimes I 

ask them to list all the things they‘ve done so far that day before coming to the class. Depending 

on how far along we are in terms of grammar, I may ask them simply to list in their journals all 

the verbs they can think of that they performed that day. I may ask for some extravagantly high 

number of verbs, such as twenty or thirty. After they finish writing, ask if anyone would share a 

verb they think nobody else in the class did. After we hear some of those (and get a little 

introduction into the students‘ lives) I ask for a verb they think everyone in the class likely 

performed, something like ―drank a cup of coffee‖ or ―got up.‖ Armed with a common verb, I 

write something like the following on the board: I got up, or I drank my coffee.  

Tan Words: Then I ask someone to identify the verb and ask if anyone can tell the mood of the 

person or the context of the action from the verb. Of course, no one can tell much at all that is 

personal or particular from the usual writing. If writing is like painting, then such verbs as ―get‖ 

―go‖ ―say‖ etc… are tan words, as if you were painting with tan all the time. No color, no 

variety, no mood established. I ask them to think about words as paint, to imagine red words or 

green words - colorful words that create mood or tone. I ask them to rewrite that one verb (―got‖) 

being conscious this time to choose a colorful verb that reflects their mood this morning or 

something about the context in which they ―got up.‖ If they can think of no context, they can 

make one up.  

After sharing those and discussing other options, I ask everyone rewrite another verb, ―drank‖ 

this time, twenty different ways in his or her journal. We work on this for 5 or so minutes, just 

listing, thesaurus-like, our new replacement verbs, adding color, adding flavor, to the boring 

version on the board. I generally start this as an independent exercise and then ask them to pair 

up and compare. We go around the room reading just one unique one out loud, asking what the 

verb tells us about the setting and circumstances. What sort of person would drink her coffee in 

such a fashion as, slurped, say, or under what circumstances might a person inhale his?  
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If the class really can‘t get going, or seems like they might have trouble coming up with a list of 

oddball verbs, I sometimes ask them to tell me different moods or circumstances under which 

someone might drink coffee. Then I get a series of adjectives, say, mad, delighted, scared, 

confused, unawares, etc…or adverbs such as blindly, reluctantly, etc…In this approach, I have 

sentences I hand out with thirty examples of different tones.  

I ask them to choose ten of the following to edit for verbs appropriate to the context, all of which 

should represent drinking in some capacity. Generally this is more successful in groups, but I try 

to get them to work alone for part and in groups for part.*  

1. I blindly_____________________out of bed.  

2. Scared to death, I ___________________________out of bed.  

3. I was so delighted with the news, I _____________________out of bed.  

4. I ____________________________out of bed when I heard you on the news this morning.  

5. The Martian landed at the foot of my bed and __________________________my cup of coffee.  

6. Feeling ill, I ___________________________out of bed.  

*The issue of the cliché comes up inevitably, happily, here, generally student generated. It‘s a perfect 

place for discussion of the cliché as sister or brother to the tan (aka boring) verbs. 

If the class is really lively, I ask them to act a few out. Before I send them on their way, I set 

them up for the homework by distributing the handout below: 

 I have several slips of paper with various contexts written on them, such as:  

a) I just heard on the radio that my company is closing its doors after 25 years of service. 

b)  I have very, very, VERY special plans for that evening.  

c) I just committed a serious crime (such as murder) the evening before.  

d) I live in the year 2290 on a satellite of Mars.  

e) I‘m not looking forward to my final exam in Chemistry that day. 

 

You could go easier on yourself and them by just writing adjectives on the slips of paper— I‘m 

feeling: Dejected Happy, Excited, Hesitant, Egotistical, and so on. Ask them to choose one slip 

to use as context for their homework. It has worked well in past when you have three people 

doing the same one without knowing it, so I usually make repeats of each.  
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Reaching for Lively Language Writing Assignment (attached to the above classroom activity): 

After you‘ve selected a style in which to write your paragraph, please rewrite the following 

paragraph, choosing livelier verbs in particular to reflect who you are and what you are feeling. 

Without your saying so, we should be able to figure out the context. You are welcome to add 

details to make your paragraph juicer and your tone clearer. You may end up with several 

paragraphs to convey your recounting of the day‘s events.  

 

After I got up and drank my coffee, I went to work. It was a long, hard day at work. I finally got 

home late around 7 pm. When I got home, I ate dinner, watched some TV and then went to bed. 

 

In class the next day, they can get up and read, read in pairs or small groups--however you want 

to work it. A good follow up activity is to recognize that there is likely no topic sentence on these 

paragraphs. As a group, in pairs, or as an individual class or home assignment you could ask 

them to write topic sentences for their own or a peer‘s paragraph. It‘s likely the topic sentences 

will look like the slip of paper they selected that contained their assigned context.  

Paige Rogers 

One activity we did that was particularly effective was designed to bridge student experience 

with what they already knew about argumentation. Using a CD Rom software interface, the 

students were asked to apply Aristotle‘s appeals to reason to the creation of an advertisement. 

After showing the group their ads, they were then asked to analyze the use of these rhetorical 

tools to explain how and why the ad worked, in addition to identifying who the target audience 

was intended to be. When the students were assigned to do their next formal essay, they easily 

employed the appeals to reason in order to make their arguments (not about advertising this time) 

more effective. 

Monica Walker 

To address the kinds of out-of-school problems that can interfere with student success in courses, 

I polled my students regarding issues of concern to them (academic, personal, social). I then 

arranged for Mike Senko and Sian Reid, both from the Counseling Department, to visit my  

class. I sent them the results of my poll. When they visited the class a few weeks later, they were 

able to focus the discussion on issues my students were concerned about. This activity was a 

tremendous success in terms of helping me to establish a strong rapport and bond with my 

students early in the semester.  
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Jackie Scott 

Activity to do to help students organize thoughts for cause and effect essays: Write four topics 

(could focus on social issues like teen pregnancy or global warming) on separate index cards. 

Divide the class into pairs. Have each pair construct a chart that lists the possible causes and 

effects for each issue. Then, have a representative from the group write their chart on the board 

for the class to review. Review each list with the class to determine if each item is relevant to 

their topic and whether it fits the term ―cause‖ or ―effect‖. Then, help the class determine which 

points would make good subtopics for each topic.  

 

Tim Nelson 

One of my favorite ALP activities is one I used over a number of class periods using a free 

resource at Bedford St. Martin's website: PowerPoints at Bedford St. Martin's website – 

bedfordstmartins.com . Click on "English" link Click on "Composition" link Find Bedford Guide 

for College Writers link Log in – instructor will need access user name and password. Contact 

your Bedford Rep.: Steve Saling Select "Go to Instructor Edition" Select PowerPoints under 

"Instructor Resources" Under the heading "Grammar and Punctuation," there is a listing of  

sixteen topics, from commas to word choice. These are brief PowerPoint presentations with 

quizzes. I like these presentations because they are straightforward and address areas of common 

mistakes in an easy-to-understand fashion. Each lesson has a quiz that follows. I ask the students 

to "vote" on the answer possibilities in the multiple-choice questions. They actually participate in 

this friendly competition. It works!  

 

Sandra Grady 

A variation of the Grammar Bootcamp that Denise Fair developed. It is a competition. I bring in 

cards with various sentence structures written out (e.g. a complex sentence that uses a 

prepositional phrase or a simple sentence using a present tense verb). Students are divided into 

two teams. This is a timed exercise, and the students must construct the required sentence in the 

allotted time. The students like the competition. They know that it is important to understand 

how to construct a variety of sentence types and use a number of elements of coordination and 

subordination for effective communication. I also include verbs and modifiers as part of the 

structures. This exercise gives them a chance to practice what they know. The winning team is 

usually allowed to leave early while the losing team remains and practices grammar rules.  

http://bcs.bedfordstmartins.com/bedguide8e/Player/Pages/Instructor_Home.aspx
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Linda De La Ysla: Review Test –  

Standard English Verbs 

 

Cross out the two nonstandard verb forms in each sentence below.  Then write the standard 

English verbs in the space above. 

 

Example : When our teacher be angry, his eyelid begin to twitch. 

My mother work for the local newspaper; she take classified ads over the phone. 

 

Last week the city tow away my car; this morning I paid sixty dollars and pick it up from the 

towing company. 

 

When my wife be late for work, she rush around the house like a speeded-up cartoon character. 

 

Henry love to go camping until two thieves in the campground remove his cooler, stove, and 

sleeping bag from his tent. 

 

If the baby have a bad cold, I takes her into a steamy bathroom for a while to ease her breathing. 

 

Although my little girls knows they shouldn‘t tease the cat, they often dresses up the animal in 

doll clothes. 

 

Whenever my brothers watches Monday Night Football, they screams at the TV as if they are 

actually at the game.  

 

The hot, sweaty children jumps into the cool water of the pool and splashes around like a couple 

of happy seals. 

 

I show the receipt to the manager to prove that the clerk had accidentally overcharge me. 

 

As far as our son be concerned, oatmeal taste like soggy cardboard. 

 

Review Test for Irregular Verbs 

 

Write short sentences that use the form indicated for the following irregular verbs: 

 

Example:  Past of grow:  I grew eight inches in one year. 

  

Past of know_________________________________________________________________ 
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Past participle of take 

_____________________________________________________________________________ 

Past of give 

______________________________________________________________________________ 

Past participle of write 

______________________________________________________________________________ 

Past of bring  

_____________________________________________________________________________ 

Past participle of speak 

_____________________________________________________________________________ 

Past of begin 

_____________________________________________________________________________ 

Past of go 

______________________________________________________________________________ 

Past participle of see 

______________________________________________________________________________ 

Past of drive 

_____________________________________________________________________________ 

 

 

Editing for Expression 

Peter Adams: Editing for Expression 

Copy the following sentences into a word processing document. Then proofread them carefully 

and correct any errors. All errors will involve expression. You will need to reword some of these 

to eliminate the expression problem. 

1. Much to my amazement and dismay, no one else objected. 

2. Teachers that understand how much work students have to do are fairly unusual. 
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3. My second draft of Paper 1 is much different than the first draft. 

4. Often many marriages break up as a result of the financial crisis caused when one of the 

spouses becomes unemployed. 

5. Effie is going to try and find the origin of ―the stuff of thought.‖ 

6. I was very fascinated by their work. 

7. I did well on my midterm due to the fact that I had studied all weekend. 

8. Phil is going to try and graduate by June of 2012. 

9. The reason we don‘t have any savings is because we don‘t make enough money to pay our 

bills. 

10. It was only recently that I actually knew it was happening to me. 

11.This exercise is different than the one we did last week. 

12. The parking situation at CCBC really aggravates me. 

13. He proceeded to escort me on a tour of the pipe mill. 

14. Drivers that try and text while they are driving are going to get tickets.\ 

15. Chan is anxious to finish with Paper 1. 

16. The  price of gas is getting so high. 

17. My younger brother has a higher level of stress than I do. 

18. Almost everyone in life will someday have to seek employment. 

19. I don't think tenure gives the job security today that it once did in the past.  

20. This course has a higher level of difficulty than ENGL 052.  

  

Bob Miller:  Expression 

Correct any errors in the sentences.  If there is no error, then just write the words "no error" at the 

end.   

1.  In my opinion, I think that the price of gasoline is to high. 

2.  Mike use to no several people who worked in Washington. 

3.  A dead corpse was lying in a table in the middle of the room. 

4.  Kris‘ did better at the audition then I did. 

5.  Personally, I like all kinds of deserts accept custards. 

6.  George will try and send you an e-mail tonight, but he isn't sure weather his computer was 

working. 

7.  Well, the Ravens were suppose to loose this game, but their a head by twelve points. 

8.  We bought alot of clothes that we should of brought weeks ago. 

9.  I need a little piece and quite after the hectic day I have had. 

10. I found a tiny little whole in the pipe that connect‘s too my water heat. 
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Appendix E: 

Technology Topics 

The information below can be copied and pasted to create handouts for your students. 

Locations of Computer Labs 

Catonsville Campus:  

The  Y (Library) Building, has computers and printers (10¢ per copy). The Student Success 

Center (also in the Y Building), has computers and printers (10¢ per copy). Finally, the Writing 

Center is in the Y building has student access computers. 

 

Essex Campus:  

The main and second floors of the library, the P building, has computers and printers (10¢ per 

copy). The Writing Center, E Building (E-338), has computers (limited printer access), and the 

Student Success Center (A-307) has computers and printers for use (10¢ per copy). There are 

also computers available (without printers) in the J Building (first floor), the B Building 

(cafeteria), and in the Cyber Cafe in the F Building (first floor – NOTE – the F building is 

currently under construction and not available). 

 

Dundalk Campus: 

The Student Success Center, J Building (J211 B; 443-840-3666), has computers and printers. 

Hours: Monday - Thursday 9 a.m. until 7 p.m.; Fri. 9 a.m. until 4 p.m.; Sat. 10 a.m. until 2 p.m. 

The library, which should reopen in July, 2011, has computers and printers available (10¢ per 

copy). There are also a number of computers available in hallways of buildings, but no printers 

are available for them. 

 

Owings Mills:  

There is an open lab in room 318. Printing service is available. If your class has computer access, 

students can use them. 

 

Hunt Valley: 

Computers in classrooms will print to printers in classrooms. Paper is a hot commodity—bring 

your own. There is limited copying for instructors only in the office. Students should bring 

storage devices 
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(CDs, USB flash drives) since the classroom computers will not store any files long term.  

Instructions for Saving Documents 

On your PC, click on the ―Start‖ button at the bottom left screen. Select the ―Microsoft Office‖ 

button, then select ―Microsoft Word.‖ After the page opens, click the icon in the top left corner 

and select the "Save As" button. A dialogue box will open. Navigate to the place you want to 

save and name the file. Your document and changes you make to a document are not saved to 

disk until you issue a ―Save‖ command. Saving is quick and easy. You should save often to 

minimize the loss of your work. Word has two ―Save‖ commands – ―Save‖ and ―Save As‖ - 

that work similarly. Both are under the ―File‖ menu. 

Save Save As 

When you save a new document for the first 

time, Word displays a dialog box. Select 

where you want to save your document and 

give it a name. When you save an existing 

document that you have been editing, the 

newly saved version is written over the older 

version. 

This command always displays a dialog box 

where you can choose a document name and 

disk. Use the Save As. command whenever you 

want to save a copy of the current document 

under a different name or in a different folder (or 

disk). The newly saved copy becomes the active 

document. 

Advice on Buying a Computer  

Students may ask you for advice on buying a computer. They will have two basic choices: a pc 

or a Mac system. Both have advantages and disadvantages and, to be honest, it is impossible to 

know which is best for them. First, however, you might want to help them figure out their 

finances. How much can they afford? Is that expensive computer going to mean more hours of 

work and less hours of study? Second, does the student want a desk top (which will remain at 

home) or a laptop to bring to school. 

Have student talk to their classmates and friends who have computers and find out what they like 

and dislike about their computers.  

Have them go to a number of stores,  try the computers, talk to the sales people, but remember 

that a store‘s job is to sell computers and not to get your student the computer which best fits 

needs.  
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It will be very helpful during a college career to have Microsoft Word installed on the computer. 

Many teachers will ask students to email assignments, and many of them will not be able to read 

files from other programs. 

USB flash drives 

USB flash drives are a highly convenient way to store and transport your files. They are readily 

available at many electronics stores in varying capacity. Remember, the higher capacity, the 

more expensive the USB unit will be. For reference, a CD-ROM disc holds approximately 

700mb of information, and a single-layer DVD-ROM disc holds approximately 4.7GB of data.  

One caution about USB flash drives: they're easy to lose. Don't use them as the only 

location for your files. Always store a copy on a computer you have regular access to, on your 

CCBC sky drive, in your email, or as a last resort, on another USB flash drive.  

The following are instructions for the use of USB flash drives:  

Insert the device into the USB port in your computer. If you are running Windows XP or 

Windows Vista, the recognition process should be automatic. You will receive a balloon pop-up 

window at your system tray regarding this process. Do not use the drive until the balloon pop-up 

states "Your new hardware is installed and ready to use." Once installed, you will either have a 

new mount point in Linux/BSD based software, or a new assigned drive letter in Windows. A 

computer with many drives may have a mid-alphabet letter, such as I: or J:. For the purposes of 

this How-to, focus will be maintained on Windows systems.  

Create a file to be saved, or use an existing file. 

Inside an application:  

Open the File -> Save OR File -> Save As... to save a copy. At the drop-down box at the top of 

the Save dialog, look for your new drive. It will most likely be titled ―Removable Disk X‖: 

(Where X is the letter mentioned earlier).  

Using Windows Explorer:  

Browse to your file using ―My Computer.‖ Right-click (context click) on your file. Select the 

―Send To...‖ Option. Click on ―Removable Disk X.‖  

Note: The Explorer method saves only a copy of the file to your drive; it will not move the 

original file.  
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Ejecting the flashdrive 

Click on the icon with an arrow and rectangle in the system tray to eject your flash drive. Make 

sure you quit all savable applications such as Microsoft Word, PowerPoint, and Excel before 

doing so. If you put your arrow over all the icons on the bottom of your screen, you will see one 

that says: ―safely eject hardware‖. Always click on that and follow the directions to make sure 

you don‘t hurt your flashdrive. Not only are flashdrives easy to lose, but they can break easily as 

well, losing all the work you have saved there. 

Blackboard  

NOTE: Blackboard is replacing WebCt beginning as of June 1, 2011.  Expect a lot of confusion 

from your students and yourself. This document cannot take the place of Blackboard training, but 

hopefully will give you some ideas to start. Take a training session and use the help frequently. If 

you don‘t get the main Blackboard help screen, then Release 9.1 will be on the left menu and that 

will lead you to a number of Blackboard help documents and videos. Blackboardondemand is 

also extremely helpful in setting up your class. While we tried to make this information as 

accurate as possible, it is possible that in this first handbook, Blackboard is so still new; some 

information may be incomplete. If so, contact the helpdesk or email Darlene Dockey if you need 

any other information. 

Logging in to Blackboard  

All Blackboard users can obtain their login information through the CCBC Online Information 

System, or SIMON. 

 The URL for the SIMON home page: http://www.ccbcmd.edu/logon/index.html 

 You should have only 1 name and password for all your CCBC accounts.  

 If you don‘t as of yet have an account and are new to SIMON, you will first have 

to create a user name. Click the ―Log On‖ button in the upper right corner of the 

SIMON home page and follow the steps on the left under ―Create A New User 

Name.‖ 

 Once you have created a SIMON user name, you can use the ―Log On‖ button to 

access your SIMON account. On the ―Main Menu,‖ scroll down and click on 

―Student Email and Unix Account Information.‖  

 If you have any issues, call the help desk: 443-840-HELP.  (4357) 

http://ccbchelpdesksupport.ccbcmd.edu/ics/support/default.asp?deptID=8106
http://ondemand.blackboard.com/
mailto:dcockey@ccbcmd.edu
http://www.ccbcmd.edu/logon/index.html
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Login access to your ―BLACKBOARD‖ page will not be available until you open it to your 

students or the first day of classes. (unlike Webct which was open as soon as the section opened 

it)  

To login, go to the ―faculty and staff‖ link on top of the CCBC homepage and then scroll down 

to Blackboard 9.1 (Your students can do this as well). Blackboard can also be reached through 

MyCCBC or finally click on the following link: Online Learning (Blackboard). On the 

Blackboard Learning System entry page, click ―Log In.‖ (The Course List feature is not used at 

CCBC.)  

 The next page displays a box where you will enter your user name and password. 

But before proceeding with the login process, click on the ―Check Browser‖ 

button on the right side of the screen. Blackboard will run a quick check of your 

system to make sure it works with your computer. Also note the information 

regarding Pop-up Blockers and Java Security Certificate. You must accept, or run, 

the Java Security Certificate in order Blackboard to function properly. If you have 

any questions, ASK FOR HELP! 

 Now enter your user name and password, and click OK. You will log in to your 

personal BLACKBOARD page, where you will see all of the CCBC credit classes 

which you are teaching, including those that are not online. In the current version 

of Blackboard a section will be created automatically for every CCBC course, 

even if the instructor does not use it. Your students will see a list of all their 

courses; even if the instructor is not using Blackboard, the class will still be listed. 

Checking grades for courses using Blackboard 

Most of your students will be anxious to see their grades, so the following information may be 

helpful for your students. 

 Log on to Blackboard 

 Select your class.  

 Once you are on the Blackboard homepage, look for the tool bar on the left side 

of your screen. Look for the "Grade Book" button. Click the "grade Book" button. 

This will allow you to see your grades. If you do not see your grades posted, ask 

your instructor. 

 

http://ccbcmd-bb.blackboard.com/
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Assignments and on-line in Blackboard 

Blackboard has an assignment feature which will automatically tie into your grading system. It is 

also very helpful for students who have missed a class. For help with assignments and other 

features in Blackboard go to the link provided earlier or try the Blackboard help page. 

Buster and Assembler  

To create a macro that will "bust" an essay into separate sentences to make proofreading easier, 

use the macro created by the following instructions:  

Buster for Word 2007 

1. Under the View tab, click on the Macro tab (all the way on the right)  

2. Select Record Macro  

3. Name the macro something you will remember. I call it Buster.  

4. Click on the button with a hammer on it.  

5. In the left hand window, click on the Normal.NewMacros.Buster line.  

6. Then click the Add>> button in between the two windows.  

7. Click okay.  

8. Click okay again. 

9. Click the Home tab on the left.  

10. Click Replace on the right.  

11. In the Find What window, type in a period.  

12. In the Replace with window, type a period.  

13. Then click More at the bottom of the window. 

14. Click the Special button at the bottom of the window.  

15. Select Manual Line Break.  

16. Repeat this step four more times.  

17. Here's what you should now see in the Replace with window:  

18. .^|^|^|^|^|  

19. Click Replace All.  

20. Click OK.  

21. Click the X in the upper right corner of the Find and Replace window to close it.  

22. Click the View tab on the right.  

23. Click the Macro button (on the right) and select Stop Recording. 

Assembler for Word 2007 

Follow these instructions to create a macro that will reassemble your paper into essay format. 

http://ondemand.blackboard.com/
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1. Under the View tab, click on the Macro tab (all the way on the right)  

2. Select Record Macro  

3. Name the macro something you will remember. I call it Assembler.  

4. Click on the button with a hammer on it.  

5. In the left hand window, click on the Normal.NewMacros.Buster line.  

6. Then click the Add>> button in between the two windows.  

7. Click okay.  

8. Click okay again.  

9. Click the Home tab on the left.  

10. Click Replace on the right.  

11. In the Find What window, type in a period.  

12. Then click More at the bottom of the window.  

13. Click the Special button at the bottom of the window.  

14. Select Manual Line Break.  

15. Repeat this step four more times.  

16. Here's what you should now see in the Replace with window:  

17. .^|^|^|^|^|  

18. In the Replace with window, type a period.  

19. Click Replace All.  

20. Click OK.  

21. Click the X in the upper right corner of the Find and Replace window to close it.  

22. Click the View tab on the right.  

23. Click the Macro button (on the right) and select Stop Recording. 

 

Green Commas in Word 2007 

 

1. Under the View tab, click on the Macro tab (all the way on the right) 

2. Select Record Macro 

3. Name the macro something you will remember, such as GreenCommas. The name must 

be all one word. 

4. Click on the button with a hammer on it.   

5. In the left hand window, click on the Normal.NewMacros.RedCommas line. Then click 

the Add>> button in between the two windows.   

6. Click okay. 

7. Click okay again. 

8. Click the Home tab on the left. 

9. Click Replace on the right. 
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10. In the Find What window, type in a comma.  

11. In the Replace with window, type a comma. 

12. Click the Format button at the bottom of the window and select Font. 

13. In the Font Color box (near the middle of the window), select Green. 

14. In the Size window, select 14. (or 16 if you‘d like them a bit bigger) 

15. Click OK.  

16. Click Replace All. 

17. Click OK. 

18. Click the X in the upper right corner of the Find and Replace window to close it. 

19. Click the View tab on the right. 

20. Click the Macro button (on the right) and select Stop Recording. 

 

Black Commas in Word 2007 

 

1. Under the View tab, click on the Macro tab (all the way on the right) 

2. Select Record Macro 

3. Name the macro something you will remember, such BlackCommas (it has to be all one 

word). 

4. Click on the button with a hammer on it.   

5. In the left hand window, click on the Normal.NewMacros.BlackCommas line.  Then 

click the Add>> button in between the two windows.   

6. Click okay. 

7. Click okay again. 

8. Click the Home tab on the left. 

9. Click Replace on the right. 

10. In the Find What window, type in a comma. Then click Format at the bottom of the 

window.  In the box labeled Font Color, click on Green.  In the Size window, click on 14 

(unless you used 16 before).  click Okay. 

11. In the Replace with window, type a comma.  

12. Click on format and select Font. 

13. Under font color select Black (do not select "automatic")    In the Size window, select 12. 

14. Click OK. 

15. Click Replace All. 

16. Click OK. 

17. Click the X in the upper right corner of the Find and Replace window to close it. 

18. Click the View tab on the right. 

19. Click the Macro button (on the right) and select Stop Recording. 
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Appendix F 

Confusing Words List 

 
 

ENGL 052 

 

 

amount, number    

   

anyone, any one    

   

as, as if, as though, like   

       

bad, badly 

 

bought, brought 

 

can, may     

   

capitol, capital     

   

cite, site, sight     

   

complement, compliment   

   

course, coarse     

       

do, due 

 

emigrate, immigrate    

   

everyday, every day    

    

explicit, implicit    

    

farther, further 

 

feel, think     

   

fewer, less   

 

lay, lie  

 

like, as      

  

passed, past    

 

precede, proceed    

   

principal, principle    

     

quotation, quote 

 

real, really 

 

raise, rise     

       

set, sit      

   

weather, whether   

 

who‘s, whose  

everyone, every one   
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ENGL 052 students are also responsible for using these words from the ENGL 051 Confusing 

Words list. 

 

 

annoy or irritate  rather than aggravate 

because of   rather than due to 

could, should, would have rather than could, should, would of 

different from   rather than  different than 

eager    rather than anxious 

he or she   rather than he/she 

people who   rather than  people that 

reason is that   rather than  reason is because or reason is why 

try to    rather than try and 

supposed to   rather than suppose to 

used to    rather than use to 

very     rather than so or pretty 

 

For more work and exercises on confusing words, go to about.com. 

 

 

 

 

 

 

 

 

 

http://grammar.about.com/od/alightersideofwriting/Glossary_of_Usage_Commonly_Confused_Words.htm
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Appendix G 

A Faculty Member’s Quick Guide to Financial Aid 
 
From: 
Achieving the Dream 
Financial Literacy Subcommittee 
 

Being aware of a few basic financial aid rules may prove to be helpful when interacting with 

your students. A few frequently encountered scenarios are listed below for your reference. Please 

note, however, that financial aid regulations are often complex and change from time to time; the 

information provided serves only as a resource. Additionally, since each student‘s individual 

situation may vary, please always refer students to the Financial Aid Office. 

 
Full-Time vs. Part-time Students 

 
There is a student in your class who seems to be overwhelmed with the demands of the course. 

Upon further investigation, you discover the student has a family and a full-time job. The student  

 

 

also informs you that he/she must be a full-time student in order to receive financial aid. Is this 

correct? 

 

No, a student does not have to be full-time in order to receive financial aid. Financial aid 

awards and cost of tuition are adjusted (pro-rated) according to the number of credits the student 

is registered for. Typically, the rule of thumb is, if a student has a fulltime job, he/she should 

attend school on a part-time basis. In many situations, financial aid can be awarded to a student 

who is only enrolled for one course. The main exception to this rule applies to students who have 

applied for a Federal Stafford loan; students with loans are required to be registered for at least 

six credits. Many students are unaware that they may attend school part-time and should 

be directed to meet with a financial aid representative to discuss the matter further. 

 
Book Allowances 

 

One of your students is not turning in any homework and does not have the textbook to complete 

in-class assignments. You have a discussion with the student and learn that he/she has not 

received “money from financial aid” to pay for books. What advice do you give? 

 

If a student adhered to the stipulated financial aid application deadlines, this type of scenario 

should not occur. However, if a student applied after the deadline, he/she is awarded provisional  
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aid so they may begin classes. This provisional or temporary aid is extended to the student until 

the financial aid office receives confirmation from the federal government that student is indeed 

eligible for aid; this process can take up to two weeks. This provisional aid does not cover the 

cost of books. With regard to advice, you may encourage the student to share with a classmate, 

borrow a copy from the library, access a text online (if they have access to a computer), or 

browse online for a relatively cheap used copy. Students should also be reminded to frequently 

check-in with the Financial Aid Office for an update on his/her financial aid eligibility status. 

 
Course Withdrawal 

 
A student in my class is struggling with the class content and as a result is doing very poorly. 

After failing the midterm, should I advise student to either audit or drop the course? 
 

If there is little to no chance that the student can successfully pass the course, you could 

recommend that student ―drop‖ the class. For students receiving financial aid, audits are not 

permitted. Students should be strongly urged not to ―drop‖ the class if it is within the first three 

weeks of class (unless there are excessive absences and there is no possible way for hi/her to 

―catch up‖). As referred to earlier because each student‘s individual situation may vary, it is 

crucial that students be referred to the Financial Aid Office BEFORE dropping courses or 

withdrawing from school. 

 

 

Nonpayment /Financial Aid Eligibility 

 
Before class one day, a student frantically informs you that she was “dropped” from all of her 

classes for non-payment but assures you that a mistake has been made because she received 

financial aid. Should you allow the student to attend class, while the matter is being 

“straightened” out? 
 

 

No, a student should not be permitted to attend class until the issue has been fully resolved. She 

should be immediately directed to the financial office for further information. For example, a 

student may have received the provisional aid referred to earlier. The Federal government later 

informs CCBC that student provided inaccurate information on the Financial Aid Application; 

this results in her no longer being eligible for financial aid. 

 

In other cases, students may be suspended from receiving financial aid due to a lack of 

satisfactory academic progress. The financial aid office monitors academic progress and students 

must meet certain criteria in order to continue receiving financial aid. As mentioned in the above  
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scenarios, some students are unaware that their aid has been suspended and must meet with a 

financial aid representative to discuss the matter further. 

 
What is the FAFSA? 
 

The FAFSA is the Free Application for Federal Student Aid. It is the first step in the financial aid 

process and must be completed by students interested in applying for scholarships, grants, loans, 

and work study. The FAFSA for the upcoming academic year is available January 1st. A new 

FAFSA must be completed every year. To be considered, students should apply by March 1st of 

each year. If a student misses that deadline, he should be urged to apply as soon as possible in 

order to be considered for the Pell Grant and other types of financial aid. 

 

With regard to financial aid, what is my role as a faculty member? 
 

There are no ―assigned‖ roles for faculty members with regard to financial aid. The following 

steps, however, prove to be very helpful to the financial aid office: 

 

• Reporting non-attendance to Records and Registration is very important because it affects a 

student‘s financial aid eligibility. 

• Strongly encouraging students to make earnest, good faith efforts to attend and complete 

courses. 

• In cases that involve ―dropping‖ or ―withdrawing‖ from classes, advise students to check with 

the financial aid office first. 
 
FOR ADDITIONAL ASSISTANCE, PLEASE CONTACT THE FINANCIAL AID OFFICE 

 
Catonsville 

K Building/Room 204 A Building /Room 1 

Telephone: 443-840-4170  

EMAIL: financialaid@ccbcmd.edu  

 

Dundalk 

105 A Building 

Telephone: 443-840-3160  

EMAIL: financialaid@ccbcmd.edu 

 

Essex 

A Building/Room 149 

Telephone: 443-840-2170 

EMAIL: financialaid@ccbcmd.edu  

mailto:financialaid@ccbcmd.edu
file:///C:/Documents%20and%20Settings/RMiller2/My%20Documents/ALP/handbook/financialaid@ccbcmd.edu
mailto:financialaid@ccbcmd.edu

